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6 Preface

Why Write This Book?

This book is inspired by my own experiences learning 

about graphic design. I remember being surprised 

that it’s not easy. This is partly because novices must 

build two different areas of expertise to begin creating 

good work. In addition to learning the fundamentals 

of graphic design, we need to learn complex software. 

My book integrates these two, and this approach helps 

beginners learn the essentials more quickly, and in a 

way that reflects the nature of the field. Our creative 

process involves an integration of design strategy with 

creative software capabilities.

The goal of this book is to efficiently develop a 

strong foundation in graphic design and production 

capabilities, whether readers want to pursue design 

as a career, or gain skills that will complement other 

professions. This knowledge applies to a great variety 

of fields. Recently, in one semester, I had students 

studying advertising, business, computer science, 

engineering, a pastry chef, and a man who worked  

in the mayor’s office.

This book can also be used by individuals who  

want to independently learn design strategies and 

Adobe software.

What You’ll Learn

Throughout, my underlying goal is to help you develop 

solid design fundamentals coupled with professional 

software skills including Adobe Illustrator, Photoshop, 

and InDesign. You’ll learn about fonts, colors, images, 

logos, and layouts to engage and communicate 

effectively in all media.

Preface



7Preface

How To Use This Book

White pages: Each chapter begins with white pages 

that show examples of effective graphic designs from 

all over the world. The text explains why their design 

strategies are successful and how you can apply them 

in your own work.

Gray boxes: These boxes within the white pages provide 

you with design analysis and project development 

practice to reinforce what you’re reading.

Yellow boxes: These provide concise yet professional 

strategies.

Blue pages: These pages introduce Adobe Photoshop, 

Illustrator, and InDesign with step-by-step software 

demonstrations that also reinforce design principles 

and provide professional tips. The software skills 

are presented incrementally, beginning with the use 

of essential tools and becoming progressively more 

complex. You are encouraged to go through the book in 

order, as this will comfortably build a useful set of skills.

Those readers who are more advanced are 

encouraged to read through the blue pages, as 

they provide design tips and strategies. By the end 

of the book, you will use Photoshop, Illustrator, 

and InDesign as professionals do, understanding 

which software is best for which task. The images 

you’ll use in the software skills can be downloaded 

from http://www.bloomsbury.com/graphic-design-

essentials-9781350075047

No experience is necessary! Let’s go …

About the Author

Joyce Walsh is an educator, writer, and designer. 

As a professor at Boston University, she has taught 

over 3,000 students and looks forward to many 

more. With a passion for design, along with academic 

and professional backgrounds in both the arts and 

technology, she develops innovative courses that 

integrate principles of design with creative software 

skills. Experienced in all areas of graphic design,  

her work is featured in international exhibitions  

and publications.

Joyce wrote the first book to combine design 

principles with software. This, the second edition, 

contains the latest in graphics software techniques  

and hundreds of new globally sourced designs.

http://www.bloomsbury.com/graphic-design-essentials-9781350075047
http://www.bloomsbury.com/graphic-design-essentials-9781350075047
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Lucien Bernhard, Priester matches 

poster, 1905

This Priester matches poster was 

considered a work of genius and 

made Lucien Bernhard famous. While 

a struggling young artist in Berlin, he 

won a poster contest with this radically 

concise design. His poster successfully 

reduced the style of commercial 

communication from complex 

lithographs (Art Nouveau posters) to one 

word and two matches. Bernhard’s bold 

colors make the visually simple message 

powerful. He repeated his formula—flat 

background color, product name, and 

simple image—for over twenty years. His 

designs moved graphic communications 

forward and continue to inspire new 

designers to communicate with 

simplified form and bold colors.  

Throughout this book you’ll notice 

several historic examples that have 

helped shape graphic design over the 

past 120 years. These “hero” designers 

expressed their passion for type, image, 

color, and layout in their works. I hope 

they inspire you as you develop your 

skills in design.

1.
0

1

9



10 Chapter 1: Introduction

Graphic Design  
is Everywhere

Look around and you’ll see that 

graphic design is everywhere. It’s 

the most pervasive art form in our 

society. And when it’s good, it’s 

powerful. Graphic design influences 

our purchases with distinctive 

branding, clever packaging, and 

persuasive advertising. It also 

engages us and enhances our 

comprehension of text in websites, 

apps, magazines, and books. 

Would you like to produce 

powerful work such as that shown 

on this page? This book will 

teach you how to analyze designs 

to understand their underlying 

strategies. It will provide guidelines 

for successfully choosing and 

using colors, typefaces, images, 

and layouts. And it will teach 

you software skills with design 

exercises, so you can create your 

own influential graphic designs in  

all forms, both print and digital,  

from package designs to smart 

watch displays.  

Design Concepts

+ Examples

+ Analysis

+ Software Skills

+ Projects

We’ll use the formula above 

throughout the book. Each chapter 

provides explanations of design 

concepts, along with examples 

and analysis that reinforce this 

knowledge. This information is 

complemented with instruction in 

Adobe Creative Cloud software. The 

software skills are demonstrated 

with engaging exercises that will 

reinforce your understanding of 

design fundamentals. Projects 

provide you with opportunities for 

independent creative development 

using professional design software.

Adobe Creative Cloud

The Adobe Creative Cloud includes 

industry-standard software: 

Photoshop, Illustrator, and 

InDesign. Photoshop is the leading 

professional software used to 

optimize photographic and complex 

images. Illustrator is used to draw on 

the computer and for single-page 

layout for print and screen. InDesign 

is multiple-page layout software 

1.
0

2

1.
0

3
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and is used to organize designs 

prior to sending jobs to print shops 

or developers for digital products. 

These three Adobe products share 

a similar interface that facilitates  

the beginner’s ability to use  

the software.

A reassuring consideration: in 

this book software skills are built 

incrementally. Going through the 

chapters sequentially, you are 

provided with software instruction 

to perform each exercise. The 

software sections will advance 

your skills progressively. And the 

exercises reinforce design concepts, 

so you’ll build design capability 

along with technical facility. 

As you develop these skills, 

your confidence will grow. You will 

develop the ability to produce the 

ideas you have in your imagination. 

If you already know a bit of 

Photoshop or other programs, doing 

the exercises anyway will reinforce 

the design concepts and build your 

software skills to a professional 

level. In the later chapters, you will, 

as most designers do, combine 

your skills in all three programs to 

produce designs. Ready? Let’s go!

Functional Fine Art

Designs of words and images are 

everywhere, and when done well, 

they’re considered functional fine 

art. The goal of most graphic design 

is to communicate, but visual appeal 

can be subjective: what you like may 

differ from what another person 

likes. Regardless of style, good 

design enhances our lives, while 

bad design impedes communication 

and comprehension. 

Think about the graphic 

designs you’ve seen today. The 

examples on these pages represent 

the range we encounter daily: 

packaging, signs, logos, magazines, 

websites, and apps. Logos appear 

everywhere, from coffee cups 

to the tops of buildings, and act 

as stamps of quality and cost. 

Signs direct us to new locations, 

saving time or causing more steps. 

Advertisements, in print or flashing 

at you on the internet, can affect 

our purchases, whether we think we 

want a product or not. Magazines 

are designed to inform and 

influence readers. 

Graphic designs facilitate our 

ability to get the information we 

need, yet we’ve all experienced 

poorly organized websites that 

are incomprehensible. From 

smartphone icons to book covers, 

graphic designs influence our 

behavior for better or worse. The 

design of this book was carefully 

constructed to enhance your 

reading and learning experiences. 

As we begin Chapter 1: Introduction, 

let’s look at examples and begin 

analyzing design to discover the 

underlying strategies for success.

1.
0

4

1.
0

5

Design Concepts + Examples + Analysis + Software Skills + Projects
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Analyze Design

When the reality program Survivor 

began in the United States, millions 

were intrigued by this sociological 

competition and felt compelled 

to watch sixteen people trying 

to survive in the wilderness. But 

it’s the logo that captivated me. It 

conveys a lot of information quickly 

and effectively. At a glance you 

see the name of the program and 

a tropical island environment. Now 

look closely at the images. They are 

actually very simple shapes—the 

top half of the oval has a collection 

of overlapping palm trees; look 

even closer, the trees are all the 

same shape, simply placed at 

varying angles and sizes to suggest 

density. Notice how the tips of the 

palms overlap the oval border—this 

technique creates depth, increasing 

visual interest. 

Now look at the lower half of the 

oval: the image that we immediately 

perceive as island surf is actually 

one wavy black line against a 

blue background. It’s remarkable 

what one line can convey. Limiting 

the number of colors in a logo is 

advantageous. Here there are 

only three: black, vivid blue for 

the water, and green for foliage. 

Although limited, this color palette 

immediately provides information 

about the environment. Next, look 

at the type. It appears roughhewn 

or hand-carved, suggesting the 

castaways’ experience. Finally, 

notice how your eyes follow the 

entire design in a logical path. You 

perceived the image and read the 

text due to effective use of visual 

hierarchy: the name “Survivor” is 

largest, then the slogan “outwit, 

outplay, outlast” is in a simpler, 

smaller typeface. Your eye is 

led logically throughout all the 

information.

The following season, Survivor 

moved to another remote and 

hazardous location. The logo design 

strategy remained the same, yet 

modifications effectively convey 

the new locale in Australia. The 

new color palette is warm—orange, 

yellow and brown. It now looks hot 

and dry. The illustrations remain 

simplified—the wavy black line is 

smoothed, turned 90°, and repeated 

to suggest the wind-blown dry, red 

earth in the outback. There’s a new 

graphic element in this logo—notice 

the notches on either side of the 

oval. While abstract, these subtly 

suggest Australian themes, alluding 

to Aboriginal art or boomerangs. 

In the logos chapter, we’ll learn 

why simplicity is important in logo 

design: it enhances recognition and 

facilitates reproduction.
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This charming letter D represents 

the Best of Drinks category in 

the Washington Post’s Readers’ 

Favorites site. The design team built 

each letter using relevant materials. 

The clear parts of the D are real 

glass. The clever use of color 

creates added appeal. Red and 

green are complementary colors, 

and their pale shades work well 

to suggest a refreshing beverage. 

A basic principle (contrast) and 

two elements of design (color 

and shape) create the witty and 

effective result. You’ll read more on 

these strategies in Chapter 2: The 

Elements of Design. 

Did this title design catch your 

eye? At this size, the three letters—

ART—demand our attention, as 

they are so much larger than the 

rest of the text. This size contrast 

creates a focal point that pulls us 

into the story. There are two fonts in 

this design, with variations of sizes 

and weights. You’ll learn how to 

effectively choose and use fonts in 

Chapter 3: Typography. 

Illustration is less common than 

photography in graphic design, but 

it can be advantageous, as we see 

in this book cover. Illustration has a 

timeless quality, while photography 

can look dated quickly. If your 

project has a long shelf life, consider 

alternatives to photography. In 

Chapter 4: Images, we’ll learn 

when it is advantageous to use 

illustrations in graphic designs. 
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This poster and tote bag use 

abstract shapes and colors to attract 

our attention. Abstract images can 

be beneficial because they may 

represent many different possibilities, 

and the audience can choose their 

own interpretations. Straightforward 

type, bold colors and a handmade 

quality suggest a contemporary 

and creative community at Second 

Home. The poster is a centered or 

symmetrical layout. The tote bag  

has an asymmetrical placement  

of the text and images. We 

will explore symmetrical and 

asymmetrically balanced designs  

in the Chapter 5: Layouts.

This book attracts our attention 

with the unusual direction of the 

title that runs along a suburban 

road. The illustration includes 

bird’s-eye view of houses. White 

rectangles that look like driveways 

are used to showcase the author’s 

name and subtitles. All the text 

aligns with white backgrounds that 

help complete the illustration with 

roads and driveways. In Chapter 

5: Layouts, you’ll learn the value 

of integrating type and image to 

ensure your text will be read. 

Designers often use photographs 

to immediately communicate a 

message or set a tone. In this 

spread, we are attracted to the 

article because of the appetizing 

photo. So many cheeses! Am I 

hungry? The designer arranged 

over twenty foods by grouping 

them onto four cutting boards. The 

boards were then arranged in a 

grid format, so the many details are 

less overwhelming. In Chapter 4: 

Images, you’ll learn how to choose 

photographs and reproduce them  

at their best quality.

1.
12

1.
13

1.
14

1.
11



15Analyze Design

Who doesn’t love to pick up 

matchboxes as a memento of a 

night out? Simon & The Whale is 

a restaurant in New York City that 

draws menu inspiration from both 

coasts of the United States. The 

colors and handmade style of the 

logo evoke the relaxed and nostalgic 

mood you’ll find at the restaurant. 

You’ll learn brand design strategies 

in Chapter 6: Logos. 

Many, if not most, graphic 

designs require multiple formats, 

as we see in these Shake Shack 

packages. The Shake Shack logo 

is recognized around the world. It is 

a flexible system we’ll see more of 

in Chapter 7: Visual Themes. You’ll 

learn how to create visual themes 

and apply repetition and variation to 

achieve cohesion, consistency, and 

rhythm throughout your designs. 

Many graphic designs are 

multiple-page productions, such as 

websites, magazines, books, and 

annual reports. Printed or digital, 

the design cannot be understood 

at a glance, and the audience must 

click or flip through the pages for 

the complete experience. What are 

the similarities on the two pages 

of this Desk Plants brand guideline 

book? Consistency of fonts, image 

style, and layout provide unity and 

enhance comprehension of the 

publication. What are the slight 

differences on these two pages? 

The designer’s challenge is to be 

visually cohesive, without falling 

into redundancy, throughout a 

publication or website. Strategies for 

achieving successful visual themes 

are covered in the last chapter. All 

the information and skills you’ve 

learned will come together in 

Chapter 7: Visual Themes. 

Graphic design influences our 

impressions everywhere we go. Both 

locally and when we travel abroad, 

most places have a visual character 

established by factors like their 

climate and architecture. Designers 

use these traits when creating 

environmental graphics, such as 

signs, wayfinding systems, and 

banners. Environmental graphics 

are physical, rather than digital, and 

have an impact on real life.

The Cochon Dingue (crazy 

pig) sign contrasts comfortably 

with the traditional architectural 

details of the building. The 

wrought-iron sign hanger marries 

the contemporary design to the 

traditional architecture. The awning 

and shutters are the same blue as in 

the logo, inspired by the French flag. 

You’ll read this beloved restaurant’s 

brand update in the logo chapter. 

1.
15

1.
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1.
18

1.
16
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Waltzing Matilda is a museum 

in the Australian outback. The 

rusted steel that forms the 

structure of the sign draws from 

the stark, arid landscape. The 

rugged, straightforward typeface 

reflects the area’s stalwart identity. 

These materials were inspired by 

the outback’s rock formations, 

prehistoric craters and warm colors. 

We commonly see banners 

hanging in our communities; these 

are semi-permanent environmental 

graphics. Ideally, they reflect their 

locales. Real estate company 

Halstead wisely chose blue for 

this banner color. It is the Western 

world’s most common favorite color, 

and blue conveys security and 

orderliness. The sans-serif font and 

angular logo also set a professional 

tone. Real estate transactions 

are often the largest financial 

investment people make; these 

details help to evoke confidence in 

the firm. What color might you avoid 

using for Halstead projects? 

This sign is part of the 

wayfinding system for a riverside 

precinct in Queensland, Australia. 

Wayfinding designs consider 

humans’ intuitive method for 

finding places, and supplement 

that with signs, pathways, lighting, 

and gathering places. This site’s 

strategy encourages circulation and 

draws people down to the banks 

of the river. The identification and 

directional signs also provide history 

about the area. This area was rebuilt 

after a cyclone in 2015. Can you see 

how the materials were selected and 

designed for weather resistance? 

1.
19

1.
2

0

1.
2
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Environmental graphics are relatively permanent 

graphic designs that influence our impressions of 

a location. You’ll see them on lampposts, buildings, 

and stand-alone signage, sometimes called street 

furniture. Take a walk and find two local examples 

of environmental graphics, one good and one less 

successful. Consider what details lead to successful 

designs or unsuccessful designs. Make a sketch of 

each using a black marker.

Objective 

This exercise has multiple objectives. It reinforces  

the idea that graphic design is the most common form 

of art in our society, it provides an opportunity for 

analysis, and it allows you to become comfortable  

with sketching, so you can better communicate  

visual ideas. 

To Do 

Make sketches of two examples of environmental 

graphics, one good and one bad.

The primary goal is to start looking, analyzing 

and sketching. When we have this conversation in 

class, there’s always a banner (including these) that 

are considered good by some and bad by others. 

As you go about your day, continue to analyze the 

many types of graphic design you encounter, noting 

how each design communicates its message. As you 

progress through this book, you’ll learn about the 

underlying design strategies of successful projects. In 

the next section of this chapter, we’ll begin to develop 

your software skills, another essential component in 

creating effective graphic designs.

Design Analysis:  
Environmental Graphics

Sketches by students 

Yuling Lu and Val Su

Tip

Sketch each banner while observing—don’t trust 

your visual memory. The sketch should show the 

outside proportion of the banners, the image, 

type style, and layout. Make the sketches with a 

black marker and add notes to indicate colors. 

This conveys the design without need for a careful 

rendering. The goal is to share visual ideas without 

having to make a time-consuming illustration. As 

many of us aren’t skilled illustrators, this approach 

takes the pressure off. 

1.
2

2

1.
2

3



Chapter 1: Introduction18

Introduction to  
Adobe Photoshop 

Photoshop is used to modify 

photographs and elaborate 

illustrations for use in designs.  

For every task you do in Photoshop, 

there are at least two ways to 

accomplish it, but my approach 

is to provide you with a method 

that leads to professional-quality 

results. If you’ve been using 

computers since early childhood, 

you’ll understand many aspects of 

new software intuitively. In these 

exercises I will teach you the less 

intuitive Photoshop techniques.

The skills that you’ll develop 

in these exercises will enable 

you to optimize the appearance 

of photographs and allow you to 

make realistic, surrealistic, and 

sometimes playful modifications 

to photographs. Photoshop’s 

capabilities are vast—even full-

time professionals don’t have the 

opportunity to explore every niche—

so next we’ll concentrate on the 

tools that will be most useful as you 

begin your design career. 

Photoshop Tools

Let’s get to know the software and 

start on the left with the toolbar.  

The most essential tools for 

achieving professional results are 

labelled. In the top position, the 

Move tool is used to reposition 

objects on the page. 

In Photoshop, areas of an image 

may need to be selected before 

you can change them. There are 

three primary tools for selecting. 

The Marquee tool selects geometric 

areas, usually rectangular or circular. 

Just below is the Lasso tool, which 

can select organic shapes. Next is 

the Quick Selection tool; however, 

when you hold the mouse button 

down, you can select the more 

professional Magic Wand tool, which 

detects similar colors and groups 

them into a useful selection. 

The crop tool is used to 

permanently change the image 

format. The very helpful Eyedropper 

selects colors from a photo to be 

used elsewhere, such as in text. 

The Clone tool looks like a rubber 

stamp and has impressive copying 

capabilities, use this tool to make 

professional-quality image edits. 

The Paint Bucket hides behind 

the Gradient tool and is handy for 

filling areas with a color. The Dodge 

and Burn tools lighten or darken 

the exposure of specific areas of 

a photo. The Type tool functions 

similarly to typical type tools; 

differences arise in the display  

of type in rasterized images. 

When chosen, all the tools have 

1.
2

4
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deselect

view file  

full size

zoom in

zoom out

copy

paste

undo

multiple undos

å+d

å+0(zero)

å++

å+-

å+c

å+v

å+z

å+z

Photoshop Keyboard 
Shortcuts

 

Here’s a useful list of keyboard 

keystrokes that will save you  

time while creating projects.

custom settings that are displayed 

in the Options bar (at the top of the 

window) or the Properties panel  

(on the right). These options change 

according to the selected tool.  

Keep an eye on these options  

or properties as you use the  

various tools. 

At the bottom of the toolbar, 

the color squares functions are 

unique to Photoshop. On the top 

is the Foreground Color, the lower 

square is the Background Color. As 

with all Adobe software we’ll use in 

this book, the tiny button of black-

and-white squares allows you to 

quickly change to default colors; 

the bent arrow is used to switch the 

foreground and background colors. 

The Zoom tool behaves just like 

you’d expect; if not, turn off the 

Scrubby zoom box that appears 

in the Options bar when the Zoom 

tool is selected. You can also use 

keyboard shortcuts for zooming.

Layers: A Brilliant Feature

Photoshop layers are wonderful—

multiple layers allow you to make 

changes to specific areas of your 

image without affecting other areas. 

A new layer is created every time 

you paste an object or add text 

to a file. This allows you to edit 

images and format text or apply 

transparency (or other effects) to 

certain layers only. 

Make changes to a layer by 

clicking on the layer shown in the 

window. The layer is active when it 

appears highlighted or gray. Double-

click on a layer in the window to 

apply layer styles such as shadows. 

View or hide specific layers by 

clicking the eye icon in the left-hand 

column of the window. 

Once you have completed a 

design, you can choose to merge 

layers to reduce file size using the 

Layers panel menu. You’ll learn to 

use layers in the first Photoshop 

Software Skills pages.

We work in the default Essentials 

Workspace. Set it under Window > 

Workspace > Essentials. 

If at some point you can’t find a 

window or panel, simply reset the 

workspace by choosing Window > 

Workspace > Reset Essentials. 

Introduction to Adobe Photoshop
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The software exercises throughout the book will 

build technical skills incrementally. You will quickly go 

from basics, such as keyboard shortcuts, to complex 

layouts, so do the exercises in the order they appear. 

The software instruction also reinforces design 

fundamentals and provides many tips for creating 

professional-quality work.

Download the photos

Download two images to your desktop, 

Convertible.jpg and Archie.jpg from http://

www.bloomsbury.com/graphic-design-

essentials-9781350075047

Objectives

This exercise has several objectives. You will build 

Photoshop skills for tools that are not intuitively 

understood, such as the Lasso and Polygonal Lasso; 

learn how to use layers; resize images proportionately; 

and useful keyboard shortcuts. 

To Do

Open two images, copy one into the other. Learn to 

use the essential Lasso tool to select a figure, resize it, 

and put it in the driver’s seat.

Chapter 1: Introduction20

2 Open the files 

Start Photoshop. Open the Convertible image 

file by choosing File > Open, then click on 

Convertible.jpg and press Open. Open the 

Archie photo the same way.

Design + Software Skills 1:  
Photoshop Layers, Lasso, Image Adjustments

http://www.bloomsbury.com/graphic-design-essentials-9781350075047
http://www.bloomsbury.com/graphic-design-essentials-9781350075047
http://www.bloomsbury.com/graphic-design-essentials-9781350075047
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Copy 

Look at the top of the window, click on the 

Archie.jpg tab. Press Command + A to select 

the entire image. The dotted line around the 

image indicates it is selected. 

Now, click on the Convertible.jpg tab. Press 

Command + V to copy the Archie file into the 

convertible file. 

Find your Layers window in the lower  

right. Click on the layer with the dog  

thumbnail image. 

Layers

Notice there are two layers—this is a good 

thing! Layers allow you to edit separately. 

Click on the Eye icon on the lower, 

background layer so it is invisible. Click on  

the dog layer so you can edit it.  

21Design + Software Skills 1: Photoshop Layers, Lasso, Image Adjustment
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Lasso

Select the dog with the Lasso tool. First, 

confirm that you have the regular Lasso tool 

selected—this is the best choice for selecting 

outlines of organic shapes. The other Lasso 

options are the Polygonal Lasso tool, which 

is used to select straight edges, and the 

Magnetic Lasso tool, which is used to drive 

you insane. The magnetic version is one of 

those software tools that promises more 

than it delivers. In most instances, the regular 

Lasso and Polygonal Lasso will work more 

reliably than the Magnetic Lasso. 

With the Lasso tool, click at the outer edge 

of Archie’s left ear; keep holding your mouse 

button down as you drag around the dog’s 

figure. No need for perfection here, it takes 

practice. Trace the entire figure, finally ending 

at the beginning point. Once completely 

around the dog, take your finger off the 

mouse. You should see that the entire figure 

is surrounded by a dotted line. This indicates 

that the object is selected. 

Copy and paste

While the dog is selected, press Command + 

C, then Command + V. This makes a copy in a 

new layer. Toggle off the visibility of Layer 1 by 

clicking on the Eye icon. Notice there is a gray 

checkerboard pattern indicating transparency. 

This is because of the lasso selection. 

Be sure to click on Layer 2 to make it active;  

it will be gray, as you see here. 

Chapter 1: Introduction22
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Resize

First, toggle on the visibility of the Background 

layer by clicking on the Eye icon. This will help 

us to scale Archie to fit the car.  

Select the Move tool at the top of the Toolbar. 

Confirm you are on Layer 2—it should be gray. 

Resize the dog proportionately. Choose Edit > 

Transform > Scale. Use a corner handle and 

drag towards the center to make him smaller, 

then press Return. When resizing, handles 

appear around the figure. Press Return to see 

the resizing results and the handles disappear. 

Click on the dog and drag him to the car 

window. Position him just below the window 

edge of the door. We’re going to let his chin 

hang out. Adjust the scale, if necessary, using 

a corner handle. 

 

Tip

Last year, Photoshop made proportionate 

resizing the default; there’s no need to  

hold the Shift key down in Photoshop to  

resize proportionately anymore! If you do  

hold the Shift key down, it will allow 

disproportionate scaling. 

Zoom in 

Use the Zoom tool to get a close look at the 

dog. Select the Zoom tool, place the cursor 

near the top left, hold the mouse button down, 

and drag to the lower right of the dog. Let go 

of the mouse button. You are now zoomed 

directly to the appropriate area of the image.

 

Tip

Anytime you want to see your entire image, 

press Command + 0.

Design + Software Skills 1: Photoshop Layers, Lasso, Image Adjustment 23
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Trim 

Adjust the Opacity setting temporarily on 

Layer 2 to about 80 percent. Now we can see 

the edge of the car window as we fine-tune 

this masterpiece. 

Select the Lasso tool. In the Options bar, 

change the Feather setting to 1 px.

Select around Archie’s beard, allowing his chin 

to hang out of the car. Press Delete. Press 

Command + D to deselect. 

If necessary, you can zoom in again and 

use the Lasso tool to trim away the original 

background from Archie’s face.

Trim 

Now switch to the Polygonal Lasso to select 

a straight edge at the window. Notice the 

Feather setting goes to 0 px. This results in a 

sharp edge. Press Delete and then Command 

+ D to Deselect. Change the Opacity 

percentage to 100 for Layer 2. 

 

Tip

Typically, I use the Lasso with 0 px Feather 

edge for sharp-edge results. This image is  

an exception because of the furry subject. 



Design + Software Skills 1: Photoshop Layers, Lasso, Image Adjustment 25

13

12

Curves window

Confirm that the Channel selection is RGB—

this setting adjusts all colors in the image. 

Confirm that the lower left-hand corner bars 

display black. 

To make the image slightly darker to match 

the car lighting, click on the line in the upper-

right quadrant. Keep your finger on the mouse 

and tug ever so slightly down. Notice the 

change in the image—a very slight movement 

on the curve darkens the exposure. 

Adjust exposure

Should you find a need to adjust a 

photograph’s exposure, Photoshop provides 

automatic adjustments under the Image > 

Adjustments menu. Rather than relying on the 

auto-corrections, the best tool at this point 

for adjusting exposure is the Curves feature. 

Choose Image > Adjustments > Curves.

To make your image lighter, click on the line in the 

lower-left quadrant. Keep your finger on the mouse 

and tug ever so slightly up. Notice the change in the 

image. A very slight movement on the curve makes 

significant changes to lighten the exposure.

When satisfied with your adjustments, press OK. 

To start over from the original image, you can press 

Cancel. Or, press Command + Z and reselect Image > 

Adjustments > Curves.

11 View full size

Press Command + 0 to show full size and 

admire your results. 
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14 Practice

Save this work as a Photoshop file. Select 

File > Save As and choose Photoshop, the  

top option on the menu. That will preserve all  

your layers. 

Now put yourself in the driver’s seat. Open 

a head shot of yourself, copy it into this 

Photoshop file, and go through steps 1–13 

again. Great work! Next, try your skills with a 

different vehicle; here I am in my dream-car.
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Major Points Summary

— Graphic design is everywhere. 

—  Examples include packaging, 

logos, signs, advertisements, 

magazines, apps, books, websites 

… The list goes on. 

—  All are forms of communication.

—  Graphic design can influence our 

actions, purchases, and the way 

we live.

—  Good design is functional fine art; 

it enhances our lives.

—  Logos require simplified forms  

for effective recognition, recall, 

and reproduction.

—  Contrast is used to attract 

attention to a design.

—  Visual hierarchy created with 

typeface size and style choices 

improves comprehension.

—  Layouts organize content  

to better communicate  

the message.

—  Integrating type and image 

ensures the message will  

be read.

—  Visual themes—consistent use 

of fonts, colors, and style of 

images—provide cohesion for 

multiple-page designs, such as 

apps, websites, ad campaigns, 

and magazines.

—  Sketches help to communicate 

visual concepts.

—  For accuracy, sketch while 

observing the object.

Summary

Software Skills Summary

Photoshop Introduction

Overview of the toolbox and 

the most commonly used tools 

for beginning designers: Move, 

Marquee/Ellipse, Lasso, Quick 

Selection/Magic Wand, Crop, Clone, 

Gradient/Paint Bucket, Dodge/

Burn, Type, Eyedropper, Zoom, 

Foreground and Background 

Colors, Color Toggle, and Default 

Colors, Image, Adjustments, Curves.

Keyboard shortcuts. 

Skills: Layers, proportionate 

resizing, Options bar, curves 

adjustments.

Tools covered in depth: Zoom, 

Lasso, Move, Magic Wand.

Recommended Readings

Each chapter combines design 

concepts + examples + analysis 

+ software skills + projects on the 

elements of design, type, images, 

layout, logos, and visual themes. 

Additionally, every chapter will 

provide you with further reading 

or listening suggestions for each 

topic. To see more inspiring design, 

look for design annuals. These are 

published results of international 

competitions for the year’s best 

design. Designers use these books, 

magazines, catalogs, websites, 

and even podcasts, for inspiration 

and to keep up with trends and the 

studios that are creating great work. 

The magazine Communication 

Arts publishes a highly anticipated 

graphic design edition every 

autumn. Its interactive annual is 

published in the spring, and all 

annuals are on their website:  

https://www.commarts.com/. 

For advice and stories from 

successful designers, listen to 

Debbie Milman’s podcast: https://

www.designmattersmedia.com/

designmatters.

Read Adrian Shaughnessy’s classic, 

How to Be a Graphic Designer 

Without Losing Your Soul.

Another excellent resource is 

Beauty by Stefan Sagmeister and 

Jessica Walsh. This book explores 

design, philosophy, history, and 

science to understand how beauty 

impacts our lives. 

Thank you to Joshua Sweeney, 

Shoot for Details, for this photo  

of the Sunbeam Tiger. 

A complete list of the contributing 

designers and citations for books 

can be found in the Appendix. 

https://www.commarts.com/
https://www.designmattersmedia.com/designmatters
https://www.designmattersmedia.com/designmatters
https://www.designmattersmedia.com/designmatters
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Michael Schwab, Golden Gate 

National Park posters, 1995

Michael Schwab’s signature style 

provides timeless images that convey 

the drama and poetry of each Golden 

Gate National Park. These posters 

raised awareness and funding to 

support the costs of maintaining the 

parks. Raised on a farm in the Midwest, 

Schwab studied graphic design in 

Texas and New York, and he works in 

San Francisco. His recognizable and 

often-imitated style is minimalist, with 

the essence of each subject depicted 

in flat-black shapes, then enhanced 

with bold flat color. Notice how color 

sets a meaningful tone in each of these 

posters. The red sky over Alcatraz, an 

infamous prison, signals danger. What 

do the colors of the skies in the other 

posters convey? 

2
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1
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Creating Powerful 
Designs

Emilio Ponzi’s book cover illustration 

captures our attention with his 

clever use of design elements, 

especially color. Here, he contrasts 

warm and cool colors. Tans suggest 

dessert heat (notice the dozing 

dog). While the red title contrasts 

with pale greens and blues. Read 

on to learn the underlying strategies 

for using the elements of design to 

create engaging work.

Designers manipulate any or 

all of the elements of design when 

developing projects. An element is 

one of the simplest principles of an 

area of study. In graphic design, the 

seven elements are: color; direction; 

line; size; shape; texture, and value.

2
.0

2

2
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Lines

Let’s start with a design exercise. 

Draw a rectangle, any size. Easy for 

you, right? Now, draw two lines. Are 

you hesitating? Suddenly, drawing 

two lines becomes a difficult 

decision. You’ve probably not 

thought much about lines before, 

but they are a basic building block 

of graphic design. In other words,  

an element of design. 

Experienced designers know that 

all designs begin with four lines—the 

edges of the screen or page that 

determine the format. Of course, 

drawn lines are also used in graphic 

designs. The formal definition 

illustrates how varied lines can be: a 

line is simply a mark made by a tool 

as it is moved across a surface. 

Because lines are fundamental, 

yet so varied, the ability to describe 

them effectively will lead you to 

more successful designs. There 

are a great variety of lines, but 

they all have three attributes: type, 

direction, and quality. Type refers 

to whether it is straight, curved 

or angular. Direction describes 

the line’s virtual movement on the 

page. If your lines are horizontal, 

you can describe them as running 

east or west. Vertical lines can be 

described as going north or south. 

Indulge your descriptive abilities 

when describing the line quality. Are 

your lines thick, bold, or stout; thin, 

narrow, or slender; wavy, rippling, 

or undulating? A regular line quality 

maintains its thickness throughout. 

The quality of a line drawn with 

a slanted calligraphy pen nib will 

change, going from thick to thin 

along its length. Look at the two 

lines you drew and describe them 

using these terms.

Some successful designs use 

lines, but no color or images, to 

produce intriguing results. This 

book cover uses line as abstract 

form to convey meaning. Columbia 

University’s School of Architecture, 

Planning, and Preservation 

published this collection of selected 

student projects with a restrained 

cover design expressing many 

aspects of urban planning. What do 

these lines suggest to you? Pull the 

elastic that is the black straight line 

to reveal the title. 

The High Line is a unique park in 

New York City that was developed 
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along abandoned, elevated railroad 

tracks that run along the west edge 

of Manhattan. It quickly became 

a favourite destination for New 

Yorkers and tourists to stroll through 

gardens planted into the old tracks 

while enjoying Hudson River views 

and breezes. Using only three lines, 

Paula Scher designed this initial  

H logo suggesting train tracks. Her 

goal was to avoid an illustrative 

design and to make it look more  

like tracks than an H. 

Sidekick Solutions provides 

computer support services, and 

technicians leave these cards at 

clients’ workspaces when their work 

is completed. Their logo symbol has 

two lines: one curved up and one 

down. These combine to create 

an S, but do you also see a smile? 

And on the other curve, do you see 

a round forehead atop two eyes, 

perhaps thinking of the solution? 
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Shape

Using lines, designers translate 

the three-dimensional world into 

shapes. Shape is the general outline 

of something, whether the object 

is tangible or abstract. Shapes can 

also be defined as a closed form or 

closed path. They can be filled with 

color, texture, or tone, and they may 

appear to be flat or have volume.

The clever use of these 

immediately recognizable shapes 

draws our attention to this theater 

poster. Lasso of Truth is a play 

about the origin of Wonder Woman, 

and the three main characters 

are playfully represented by these 

similar, yet distinctive, shapes. 

The shapes in this Nike 

Instagram design are created by the 

lines on a basketball court. These 

shapes and the background photos 

suggest the energy and excitement 

of the game. 

Using minimal color and iconic 

shapes of dress-forms, hairstyle, 

croquet mallets, and balls, the play 

poster hints at the humor in this 

musical comedy adaptation of the 

classic mean-girl movie, Heathers. 

There’s a cut-throat croquet scene 

in the movie. Coincidentally, the 

color pink and similar dress are 

darkly comic themes from the 

straight forwardly titled movie  

Mean Girls.
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Value 

Value, in visual art, is defined as 

the relative lightness or darkness 

of a color. Bloomsbury’s Object 

Lessons is a series of books that 

feature an iconic object. These high 

heels are created with only three 

values, 100 percent white, 100 

percent black and gray (50 percent 

black). Additionally, the use of value 

achieves effective visual hierarchy in 

the text. We see the ‘high heel’ white 

text first because it has the most 

contrast with the black background. 

The author’s name in blue text is 

read second because it has less 

contrast with the black background. 

The other text, “Object Lessons” and 

“Bloomsbury”, are smaller, thinner 

letters, providing the least contrast, 

and are placed on the peripheries to 

be read last. 

The landscape for this book 

cover is created with several values 

of blue-green, emphasizing the 

cold location. The tallest mountain 

peak has an almost white value 

that suggests snow. Light values 

of colors are called tints and dark 

values are called shades. The 

author’s name is an almost white 

tint, which creates contrast and 

draws attention. Contrast is a term 

that describes the relative emphasis 

of an element used in a design. 

Because the title is a dark value 

and smaller, creating less contrast 

with the background, we see the 

title secondarily. The use of contrast 

with the elements’ value and size 

affects how we view the details  

of this design. The two figures in  

the illustration wear yellow and 

orange coats. Even though these 

are contrasting colors, they are 

smaller figures, so we may see them 

after we read the text. Typically, 

designers create one important 

area to have the most contrast and 

to become the primary focal point. 

Other smaller and less-contrasting 

areas can attract our eyes in a 

sequence that moves us through  

an entire design. 

Bring Your Game’s text is 

distorted to make a camouflage 

pattern in the next poster. Value 

is the design element that gives 

this image detail and texture. The 

values of this camouflage pattern 

are either 100 percent white or 100 

percent black. Teasing through the 

open areas is a photo of basketball 

great LeBron James. Many gray 

values combine to create his profile 

and figure. Notice the values are 

stronger in his face and less so 

in his figure, a contrast drawing 

our eyes to his face. Overall, the 

foreground has high value contrast, 

and the photograph has relatively 

low-value contrasting. These careful 

design decisions affect how we view  

this design. 

Contrast is often used to achieve 

greater functionality in graphic 

design. The words in this book, 

created with black ink on white 

paper, have high contrast value 

to achieve the greatest legibility. 

Likewise, the digital version of 

this book, websites, and apps use 

black text on white backgrounds to 

achieve highest contrast and best 

legibility on screens. 
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Texture

Texture in graphic design adds visual 

interest and conveys information. 

Some visual textures suggest 

inviting surfaces such as photos 

of rose petals or skin. Often, these 

types of images in advertisements 

suggest creamy products. Visual 

textures can also appear to be 

rough, like rust or sandpaper, to 

express a gritty quality. Here, we see 

contrasting textures: soft ice cream 

atop crunchy-looking cones look 

irresistible. And yes, that’s a fish-

shaped cone that doesn’t taste fishy. 

Posters for the Forward Festival 

provide a frayed, outdoor visual 

texture, suggesting they have 

been weathered by the elements. 

This effect expresses that the 

design process always involves 

construction and deconstruction. 

This handmade O represents the 

category Outdoor Events for the 

Washington Post’s Favorites feature. 

Notice the grass texture contrasts 

with the smooth rainbow, and its red 

and pinks contrast with the greens 

on the bottom. 

The cover image for “Fate” is 

a large rope knot that conveys a 

rough texture. This ominous effect is 

tempered with the pink background 

and the matte silver varnish, which 

adds subtle contrasting texture. 

These visual and tactile textures 

combine to create a mysterious 

book cover. 

Graphic designers sometimes 

use tactile effects—real textures—to 

add unique qualities to designs. 

Tactile treatments created with 

embosses, die cuts or folds increase 

the probability of engaging your 

audience. Such effects encourage 

the viewer to pick up and investigate 

the piece, improving the likelihood 

that the client’s message will be 

read. Blind embossing, created when 

a die is pressed into paper, subtly 

raises the A-shaped logo on the 

Aslan Foundation business card. The 

effect implies this organization has 

a thoughtful mission that perhaps is 

not obvious at first glance. 
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Direction

When an object is placed in an 

atypical direction, the resulting 

design engages the audience 

with a visual puzzle. This is an 

advertisement for a feed and supply 

company. The vertical direction of 

the headline is emphasized by its 

position between the horse’s ears. 

Other posters in the series include 

dog, cat, and rabbit ears, as will be 

seen in Chapter 4 when we discuss 

photo cropping. 

A head-standing skateboarder is 

the largest image on this two-page 

title spread, and she is the subject 

of the article. Her unusual direction 

captures our attention, and we are 

engaged with the playfully active 

collage in which letters and images 

intersect. Notice how one leg is 

behind the l’s, and the other is in 

front. This detail helps create depth 

and visual interest. 

The Swag Shop sign is made 

with weathered steel and cutouts. 

These textures are features of the 

wayfinding system for this museum 

in the Australian outback. The 

materials and design were inspired 

by the stark, rugged landscapes of 

the bush. 

The title on the book cover for 

The Mirror is reversed. This mirroring 

effect is enhanced with the use of 

silver metallic ink. This design uses 

two elements: texture and direction. 
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Size 

This enormous “2” is inescapable 

for its atypical size and the use of 

a single digit as a title. For the new 

designer, using size as an element 

in design is relatively easy. Simply 

by enlarging the first letter at the 

beginning of an article, you have 

introduced contrast with the body 

text. This creates a focal point, an 

entry into the text, and is a typical 

strategy used in magazines. You will 

also use size to indicate hierarchy 

of information—variations show the 

relative importance of content. 

Enormous letters are so big 

they don’t fit on this tote bag, 

creating dynamic energy with a 

visual puzzle. Most will immediately 

recognize the brand, but if not, there 

is a much smaller black-and-white 

name towards the bottom left. This 

creates effective visual hierarchy of 

information: we initially notice the 

large blue letters, and secondarily 

we notice the full name in smaller, 

regular weight, black-and-white text. 

You’ll read more about this brand 

re-design in Chapter 6. 

Size is often applied to images. 

Notice a few of the images in this 

collection of spreads from House 

Industries are enlarged and closely 

cropped. When we closely crop 

images, we achieve two goals: it 

allows viewers to examine details 

of the objects, and it provides fresh 

takes of common objects. Notice 

that some of these spreads make 

titles or letters very large, creating 

visual interest and focal points, while 

also highlighting the font designs. 
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Unity 

These playful and elegant two-

page spreads demonstrate the 

effectiveness of both unity and 

contrast in a design. Notice the 

harmonious use of the same font, 

the consistent bicycle theme and 

matte copper ink throughout 

many of the spreads. These 

details demonstrate the appeal of 

unity. Unity is a basic principle of 

graphic design and dictates that 

all of the objects in a design be 

visually harmonious such as on 

these spreads and throughout this 

catalog. Now note the contrasts 

in the spreads: some text is 

horizontal, some vertical, some 

photos are smaller and in grids, 

others are intense close-ups, and 

large numbers and titles pop-up 

throughout. These design strategies 

achieve a visually consistent and 

compelling design. 

Designers must be aware of 

how they handle formal elements. 

Whether you’re designing a logo or 

a website, the formal elements are 

always the same. The elements are 

interdependent and interact with 

one another on the page—note 

when the overall design achieves 

unity and when contrast captures 

your attention. 

We will explore the element of 

color in depth in the next section  

of this chapter. 

Objectives

You will identify and analyze the 

use of the elements of design while 

reinforcing the concepts introduced 

in this chapter.

To Do

Find seven examples of designs 

in which a particular element of 

graphic design is used to create 

visual interest. Place these 

examples in your notebook.

Design Analysis: Elements of Design
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Color

Color Connotations

Color has an immediate effect on 

its audience. Before type is read 

and the image is understood, 

color makes an impression. Red 

is passionate, whether in love or 

fury, and carries a strong visual 

message. It is favoured for designs 

ranging from national flags to sport 

cars. This theater booklet’s red 

calendar is noticeable among dark 

pages, creating an effective design 

strategy. Because red is so strong, 

its intensity sometimes needs to  

be balanced with black to produce  

a more accessible effect. 

Warm colors other than red 

can attract attention while feeling 

more innovative. Halstead’s brand 

is designed to stand out in the very 

competitive New York real estate 

market. These window banners are 

inescapable, as their hot-pink text 

creates a textured pattern on the 

orange background. The panels  

are a welcome change from the 

usual brown paper that covers 

windows when a space is for rent, 

and the effect is contemporary  

and memorable.

Blue has many positive 

connotations. Dark values of blue, 

such as navy, suggest expertise, 

authority, and a seriousness of 

purpose. Medium values of blue 

are associated with honesty and 

cleanliness. Look at the cleaning 

products on grocery-store shelves 

to confirm this point. 

Yellow is associated with warmth 

and wholesomeness, so it is often 

used for food-product designs  

to convey healthful messages. 
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Green is also healthful, 

indicating freshness and the 

outdoors. As a term, green 

represents environmentally 

sustainable products, practices, 

and organizations. The Grounds 

is an oasis in the city of Sydney. 

Their café, gardens with roaming 

farm animals, and great coffee 

provide memorable experiences. An 

illustration of Fluffy, their resident 

macaw, graces a distinctive package 

for their coffee. In addition to the 

charming illustration, the use of 

green and blue conveys their 

commitment to sustainability of the 

environment in all of the Grounds’ 

enterprises. See more color 

connotations in the Appendix. 

Some people have a natural 

facility for using color, but for most 

of us, it can also be learned. Avoid 

using only your favourites, and 

select colors that are appropriate for 

the design. Would you recommend 

the use of hot pink to a client whose 

business is financial planning? 

Probably not: for a client in a 

conservative industry, it might be 

better to choose darker colors for 

immediate and appropriate impact. 

Pastel colors are commonly used 

for children’s products and services, 

while deeper shades are considered 

more conservative. Observe when a 

design catches your eye and notice 

which colors are used to create 

particular effects.

Color Combinations

Color is a very powerful and 

provocative design element, 

but choosing multiple colors 

successfully can be challenging. 

Let’s start with an understanding  

of color theory with a focus on the 

three primary colors (red, yellow, 

and blue) and the secondary colors 

(orange, green, and purple).  

When these two groups are 

placed in overlapping triangles 

to form a circle, the relationships 

between the colors become 

apparent. Colors that appear 

opposite each other on the wheel 

are called complementary colors. 

Opposing positions are significant 

because these pairs of colors 

have the most contrast when used 

together. Contrast creates a visual 

dynamic that is often desirable in 

graphic design. The complementary 

color pairs are red and green, blue 

and orange, and purple and yellow. 

The following examples and design 

exercises will help you to recognize 

the visual power of these color 

combinations. 
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Hot and Cold

Blue and green hues suggest 

something cool and soothing, while 

red and yellow suggest warmth, even 

heat. Red, orange, and yellow are 

called warm colors; blue, green, and 

purple are cool colors. Designers 

often use more of the cool colors 

and less of the warm colors. Why? 

The warm colors do attract attention, 

but for a variety of reasons, too 

much is not always good thing. On 

computer screens, too much red 

can irritate eyes, and on white paper, 

yellow doesn’t have enough contrast 

to be legible. Blue and green have 

many positive connotations, such 

as cleanliness and reliability, and 

they have good contrast with white 

backgrounds that are common in 

all media. It is often wise to use cool 

hues generously. We will learn to 

combine cool and warm colors for 

dynamic designs. 

Few color interpretations are as 

universally agreed upon as warm 

colors and cool colors. This is likely 

due to our global human experience 

that the sun provides warmth,  

while water and foliage provide 

cooling effects. 

This unusual book, Hot to Cold, 

examines sixty architectural sites 

from the hottest and coldest places 

on earth. Notice how the colors of 

the pages change from warm to 

cool as the topics cover different 

climatic conditions. The building 

diagrammed on the orange pages 

is in a tropical rainforest. The 

buildings on the blue page are in 

Sweden. Depending on the ambient 

temperature, the book cover 

appears orange and the title says 

HOT, or the cover is blue with COLD 

appearing as the title. 
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Blue and Orange

In this photo of a room at NYU 

School of Law, cool blue chairs are 

dramatically set off against short 

orange walls. The contrast ensures 

you’ll be engaged enough to notice 

the locations and then read the 

value of diversity message at the 

bottom left. 

Lateral Cooking used only two 

ink colors throughout the book: 

orange is used to highlight page 

references, footnotes, and side-

notes, and blue is overprinted within 

the illustrated chapter openers and 

on the endpapers. This cookbook 

encourages people to expand their 

repertoire without the need for more 

recipes. The design uses reference 

book conventions, such as the 

orange step detail, which allows 

easy navigation to a specific section 

in a lengthy publication.

This field of business cards 

pops most dramatically when 

placed against a blue background. 

Notice the saturation of both colors 

is similarly strong. These boldly 

contrasting hues get our attention.
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Red and Green 

The Edible Boston hot-pink title 

pops against a mint green table. 

Look closely at the photo and notice 

the appeal of the variety of greens 

and pink foods is tempered by soft 

browns in the toasts. 

When the pale green matchbook 

cover is opened, red matches strike 

our attention. 

Yellow and Purple 

The design for the Natural High 

festival is a vibrant use of two 

sets of complementary colors and 

promises a fun weekend. Bright 

yellow typography is highly visible 

against soft purples in the photo  

of this spread. 
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Introduction to  
Adobe Illustrator 

Overview of tools in Illustrator

Color Palette in Illustrator

Drawing Tools in Illustrator 

The Illustrator Toolbar

Of Illustrator’s top ten tools—those 

that do most of the work—the most 

useful is the Selection tool. This 

black arrow is used for selecting an 

entire object or multiple objects. 

You’ll use an additional nine tools 

frequently to create projects. The 

white arrow is the Direct Selection 

tool. It is used to select a particular 

point on an object to make precise 

adjustments to graphics. The Pen 

tool will initially be challenging, but 

fun and rewarding, once you’ve 

had a bit of practice. It is used 

for drawing. Note the tiny black 

triangle at the bottom of some 

toolbar squares, which indicates 

multiple versions of a particular tool. 

The Rectangle tool has important 

variations, including the Ellipse and 

Line tools. The Type tool generally 

works in the same way as most type 

tools in word-processing software. 

However, when you put your cursor 

over the Type tool, then press and 

hold the mouse button, you’ll see 

variations of this tool. These include 

the Path Type tool for flowing text 

along any sort of line such as 

circles, waves, or an illustration (we’ll 

cover these in Chapter 3). You will 

frequently use the Rotate and Scale 

tools. The Gradient tool fills shapes 

with variations of chosen colors. 

The Eyedropper tool is useful for 

identifying objects’ specific hues. 

The Artboard tool allows you to 

customize the size of your design 

file. At the bottom of the toolbar, 

you’ll see a magnifying glass—this is 

your Zoom tool. 

Here’s a useful list of keyboard 

shortcuts to save time while 

creating projects. Good news: you 

can do unlimited undos in Illustrator. 

Depending on how much memory 

is available, you can undo your 

steps, in reverse order, by pressing 

Command + Z. At any time, press 

and hold the Command key to 

temporarily switch to the Selection 

tool while using another tool.

Tip

We work in the Essentials 

Workspace. It is the default 

setting for the software. You can 

also set it by choosing Window > 

Workspace > Essentials. If at 

some point you can’t find the 

Properties panel or other window, 

simply reset the workspace by 

choosing Window > Workspace > 

Reset Essentials. 

Keyboard Shortcuts

View full page

Zoom in

Zoom out

Copy

Paste

Undo

Switch to  
Selection tool

Switch to  
Type tool

Temporary  
switch to  
Selection tool

Temporary  
switch to  
Hand tool

See note in Chapter 1 about 

including PC commands here.

å+0

å++

å+-

å+c

å+v

å+z

v

t

å(hold)

h(hold)
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Selection

Direct Selection

Pen

Rectangle/Ellipse

Type

Rotate/Scale

Eyedropper

Artboard

Scale

Default | Toggle

Color Panel | Grient | No Color

Fill Color (top)

Stroke Color (bottom)

Gradient

news:you
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Color in Illustrator

Let’s look closely at the color tools 

in Illustrator. The two large color 

squares in the toolbar are the Fill 

and Stroke colors. The color on top 

is the Fill color. The color below is 

the Stroke (outline) color. You can 

set either to “no color” by pressing 

the small button with a red diagonal 

line (below right). The bent arrow 

toggles between Fill and Stroke 

colors. Click on the tiny white and 

black overlapping squares at the top 

left, to swap to these customizable 

default colors. To choose new 

colors, double-click on the either 

the Fill or Stroke square to open the 

Color Picker window. 

The Color Picker window is the 

best tool for selecting unique colors 

in Illustrator. At first glance it has an 

intimidating array of coded letters 

and numbers, but a bit of study 

will allow you to understand every 

aspect of this window. 

Hue | Saturation | Brightness 

In the Color Picker window, you see 

several letters. The first column 

contains HSB.

Hue, simply stated, is the name 

of the color. Illustrator displays a 

numeric value for hue that indicates 

the location of the color on the 

color wheel in degrees between 0 

and 360. To understand this range, 

imagine the rainbow strip in the 

Color Picker is formed into a circle 

with red at the top. Think of the 

circle as a clock face. Near the top, 

or 12:00, is 0° for red. Yellow would 

be around 4:00, or 60°, and blue 

around 9:00, or 200°. Position the 

slider at yellow and blue on the hue 

spectrum and note the hue values. 

Saturation can be thought of 

as the intensity of the color. Also 

referred to as chroma, it indicates 

the amount of gray in a color. Notice 

where the darker values of the color 

appear in the color field (the large 

square) inside the Color Picker 

window. The higher gray-content 

colors appear in the bottom third 

of the square. These colors are 

referred to as muted or shades. 

Highly saturated colors contain 

less gray. Consequently, the most 

saturated colors may be found in 

the upper-right-hand corner of the 

color field. Highly saturated colors 

are referred to as bold or true. 

Brightness is the amount of white in 

a color. Brighter hues appear in the 

upper left of the Color Picker square 

and are often called tints.

Out of Gamut Sign

A tiny triangle with an exclamation 

point sometimes appears next 

to the current and previous color 

rectangles to indicate that the 

current color is out of gamut. Gamut 

is the range of colors in any given 

color space. Designers work with 

many devices (computer displays, 

inkjet, and laser printers); each has 

a different color space. For example, 

a laptop display shows more colors 

HSB  Name  Range  Effect

H Hue  0 to 360   location on the standard 
color wheel

S Saturation 0% to 100% gray to fully saturated

B Brightness 0% to 100% black to white

than inkjet printers, but printers can 

produce purer blacks. When a color 

cannot be displayed on a device, it 

is out of gamut. Heed the warning 

when producing work for clients—if 

the sign appears, click the triangle 

and the selection will switch to the 

closest printable color.  
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Initial  Color  Range

C cyan  0% to 100%

M magenta  0% to 100%

Y yellow  0% to 100%

K black  0% to 100%

Initial  Color Range

R red 0 (black) to 255 (white)

G green 0 (black) to 255 (white)

B blue 0 (black) to 255 (white)

CMYK  

Cyan | Magenta | Yellow | Black

CMYK is a pigment-based 

subtractive color system that is 

synonymous with the four-color 

printing process. C is for cyan, a 

bright blue. M is for magenta, a 

bright pinkish-red. Y is for yellow, 

and K is for black. These four colors 

are used in combination to print all 

the colors in the spectrum.

This system has been used 

in various ink-based printing 

technologies for well over a hundred 

years: first lithography, then offset 

printing, and now desktop printing. 

When you use a color ink cartridge 

for your desktop printer, note the 

colors on the package: they are 

typically CMYK. The subtractive 

color system describes how we 

perceive ink-based color. As light 

strikes a printed page, the ink 

absorbs (subtracts) a portion of 

the color spectrum; what is not 

absorbed reflects back to the eye, 

resulting in the colors we see.  

When cyan, magenta and yellow  

are all absorbed by a pigment,  

the result is black, as the ink 

subtracts the colors.

RGB 

Red | Green | Blue

The computer or phone display is a 

light source, so these primary colors 

are not the pigment-based primaries 

of red, yellow, and blue. They are 

instead the additive primary colors, 

red, green, and blue, also known  

as RGB.

Your computer screen creates 

color by illuminating red, green, 

and blue phosphors. When the 

colors combine, they can create 

most of the color spectrum. When 

all colors are combined at their 

fullest strength, they create white; 

consequently, this is termed the 

additive color system. To produce 

digital display graphics, designers 

work in the RGB color mode. 

The RGB color mode provides 

brighter variations of colors 

compared with CMYK. When 

beginning a new project, always set 

the color mode initially. Choose the 

color mode by determining how the 

final design will be displayed. If the 

final design is to be printed, use the 

CMYK mode. If the final design will 

appear on a digital display, use the 

RGB mode. Avoid switching color 

modes within a file: your designs  

will lose color information.  

The Pantone Matching System

Adobe provides designers the ability 

to view color swatches in libraries 

and to organize unique groups of 

colors into swatch libraries. The 

most widely used of these is the 

Pantone Matching System. 

Pantone is an internationally 

used color system accessed 

through the swatch library. You 

should be aware of (not alarmed by) 

the term ‘PMS.’ PMS numbers refer 

to the Pantone Matching System. 

This is a standardized numbering 

system for colors, which enables 

designers and producers to specify 

particular hues by number. The use 

of PMS numbers guarantees that 

the specified hue will be reproduced 

consistently, no matter who or what 

is producing the work. For example, 

the Canadian government’s maple 

leaf has a government-decreed 

Pantone number (PMS 032) 

so that the country’s symbol is 

displayed consistently, whether on 

a government website or on a ferry 

boat to Vancouver Island. 

When working with a particular 

company, designers specify the 

brand’s PMS color. For the Tiffany’s 

2
.4

1



Chapter 2: The Elements of Design46

website, designers select the 

signature robin’s-egg blue that 

has its own Pantone number. This 

particular PMS number, 1837 

(the year the store was founded), 

is patented, and its use requires 

approval by Tiffany’s and Pantone. 

In Illustrator, to access the PMS 

color chart under the Window 

menu, choose Swatches; then from 

the Swatch window’s top-right 

hamburger menu, choose Open 

Swatch Library > Color Books > find 

the Pantone listings, and select one 

that suits your project, this one is 

Pantone + Solid Coated. 

The most common choices are 

Pantone Solid Coated or Pantone 

Solid Uncoated. These terms refer 

to the finish of the paper: coated 

paper is very smooth, so the ink 

appears brighter. Uncoated paper 

is more porous, so the ink appears 

somewhat less vibrant. Designers 

must specify whether the color is 

coated or uncoated when submitting 

a job to a printer. These colors are 

also referred to as spot colors.  

Each Adobe software accesses 

Pantone listings differently. In 

Photoshop, double-click on the 

toolbar foreground color to open 

the Color Picker window, next click 

on the Color Libraries button, then 

choose from the Book pull-down 

list; a common choice is Pantone 

+ Solid Coated. In InDesign, from 

the Windows menu, choose Color 

> Swatches, now from the top-right 

hamburger menu, choose, New 

Color Swatch; in the New Color 

Swatch window, choose Spot, as  

the Color Type, and Pantone from 

the Color Mode list. You’ll get  

used to it. 

Only Web Colors 

Only Web Colors is no longer 

relevant. If you are interested in the 

history, keep reading; otherwise skip 

to the next paragraph. Designers 

adhered to a web-safe color palette 

when websites began proliferating 

in the nineties until roughly 

2009. A web-safe color palette 

acknowledged that while your 

monitor may have been capable of 

displaying millions of colors, web 

browsers displayed only 216 colors 

consistently. Checking the Only 

Web Colors button in the lower left 

of the window allowed you to view 

only these 216 colors. 

Significant to website design, 

a six-digit hexadecimal number is 

listed at the bottom of the left-

hand column, indicated by the 

# box. Website software such 

as CSS defines colors using the 

hexadecimal (sixteen-character 

0–F) numbering system. The 

hexadecimal value for white is 

FFFFFF, black is 000000, and 

one of my favorite blues to use for 

websites is 006699. 

Now that you are expert in the 

use of the digital Color Picker, let’s 

create a color wheel using drawing 

tools in Illustrator.
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1

2

Objectives 

This deceptively simple exercise achieves several 

objectives, allowing you to develop skills in software 

drawing and deepen your understanding of color 

theory. The repetition required to draw the color wheel 

reinforces the ability to use the new tools. 

To Do 

Draw the color wheel using Illustrator’s drawing tools.

Make a new file 

Start Illustrator and choose File > New or 

Press Create New. Select Print from the 

top line of the New Document window 

that appears. Select your preferred unit of 

measurement on the right pull-down menu. 

This will provide you with default letter size 

and set the color mode to CMYK. (If you 

choose Web or Mobile, your file will have pixel 

dimensions, and the color mode will be RGB.) 

Press Create. A blank document will appear 

on your screen. We’re ready to go! 

Design + Software Skills 2.1:  
Illustrator Drawing

Confirm Essentials Workspace

We will use the Essentials Workspace 

throughout these Software Skills. Confirm you 

have the Essentials Workspace on the top 

right of your window. If not, go to the Windows 

menu and select Workspace > Essentials. If 

a panel accidentally closes, you can always 

refresh by selecting Windows > Workspace > 

Reset Essentials. 
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While the Ellipse tool shows in the toolbox, 

click once on your file workspace. Illustrator 

will place your object wherever you click, 

so click in the top center area of your page. 

Make the height and width 1 inch (2.5 cm), 

and then select OK. You’ve successfully drawn 

your first object. Admire its bold symmetry  

for a moment.

5

4

3

Make a circle

Place your cursor over the Rectangle  

tool, click, and hold. Select the Ellipse tool  

and release.

Choose a color

Select a red. 

(a). First double-click on the Fill Color square 

(b). To see a selection of reds in the large 

square, slide the arrows on the rainbow 

spectrum to the bottom

(c). If your Color Picker does not appear as  

in this image, confirm that H (hue) is selected

(d). Choose a true, saturated red by  

moving your cursor to the top right of the 

Color Picker square 

Click OK to select red and close the window.
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7

6

Make the wheel

Repeat the above directions to draw another 

circle and make it yellow. 

If your virtual triangle looks a bit wobbly, you 

can move a circle after the color has been 

changed. Choose the black Selection tool, 

click over a circle, and while holding the 

mouse button down, nudge it into position. 

Tip

A shortcut to the Selection tool is to hold 

down the Command key. Your cursor will 

temporarily change to the Selection tool, 

allowing you to move the circle. Once 

the circle is moved, and you release the 

Command key, your cursor returns to the 

Ellipse tool mode.

Make more circles

Now, draw the other colors in the wheel. 

Reposition your cursor lower and to the left  

to create another circle. 

Next, double-click in the Fill Color square 

again to bring the Color Picker window 

into view. Move your cursor along the hue 

spectrum bar to choose a blue, then select  

a specific true blue from the large square 

color field.

Continue to follow the directions in steps  

4–6 and add three more circles—orange, 

green, and purple—to complete the wheel. 

Position the colors into a wheel using the 

Selection tool. 
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9 Make adjustments

If you want your lines to meet perfectly with 

the black circles, make small adjustments to 

one end of a line with the Direct Selection tool. 

Choose the white Direct Selection tool.

First, “click off” by clicking into the white 

background area so that nothing is selected. 

Then click directly on the end of the line you 

wish to adjust. Click on the blue square at the 

end of the line and drag it into position.

8 Draw the lines

Draw black lines to connect the two triangles 

that indicate the primary-color and the 

secondary-color groups. 

Select the Rectangle tool and hold to select 

the Line tool from the sub-tool window. The 

Line tool will automatically switch your color 

selection to black stroke and no fill color. 

Place your cursor on the lower-left-hand curve 

of the red circle, hold the mouse button down, 

and drag the cursor to the top right of the blue 

circle, then release the mouse button.

Repeat this step to draw solid black lines 

among the color groups.
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10 Draw dashed lines

Draw three new lines between the 

complementary color pairs (red and green, 

blue and orange, purple and yellow). These 

three lines will cross in the middle. Use the 

black Selection tool to select all three lines by 

dragging a little rectangle at the intersection 

of these three lines.

From the Windows menu, open the Stroke 

palette. Check the Dashed Line box and  

fill in values for the dashes and gaps. Start 

with 2 pts each, then try experimenting  

with other values.

11 Finishing off

You can make the lines and circle outlines 

thicker by selecting them and then increasing 

their weight in the Stroke window.

Save your work by using the keyboard 

shortcut Command + S. Phew. You have 

completed your first Illustrator drawing.  

Well done. Break time! 
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2 Copy the wheel

Return to your Illustrator color wheel file 

for a moment to copy it into Photoshop. In 

Illustrator, click on the file. Use keyboard 

shortcuts to select the entire image and make 

a copy. Press Command + A, then Command 

+ C. Your image will look like this when the 

color wheel is selected.

1 Create a new file

Open Photoshop and create a new file by 

choosing File > New. Choose Letter size, 

inches, Resolution set to 300, and leave  

the remaining options as the default values. 

Press Create and a new file will open on  

your screen.

Objectives

Demonstrate the differences between Illustrator and 

Photoshop image types, called vector and raster 

images. This exercise also shows the compatibility of 

Illustrator and Photoshop. In addition, you’ll use one  

of the fun features of Photoshop: Filters.

Design + Software Skills 2.2:  
Photoshop Vector vs. Raster Images 

To Do

Copy the color wheel from Illustrator to Photoshop. 

Compare the two types of images: vector and raster. 

Then get creative in Photoshop by applying various 

filters to the color wheel graphic.

Photoshop was introduced in Chapter 1. Now let’s 

expand your Photoshop skills.
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3

4

Paste in Photoshop

Return to your Photoshop file by clicking 

on the Photoshop icon in the dock. Press 

Command + V to paste the color wheel into 

your file. Photoshop will prompt you for a 

Paste type. Select Pixels, because this graphic 

will be converted to a raster image. Then click 

the OK key to place the graphic into your file.

Layers

Note that the graphic is placed into a new 

layer. Remember, Photoshop creates a 

new layer every time you paste an object 

into a file. Layers allow you to edit graphics 

independently; it’s a very good thing.


